EndNote: Building and organising your library

EndNote is a bibliographic management / referencing software that allows you to create, organise and maintain a personal database of references called an EndNote Library.
Contents
Create an EndNote library ............................................................................................................... 4
Create an EndNote Library when you open the software the first time ........................................ 4
Create an EndNote Library using the File menu .......................................................................... 4
An overview of your library’s home screen .................................................................................. 5
Type the record yourself ................................................................................................................. 6
Tips for Entering Data .................................................................................................................. 8
Author and Editor fields: How to put names in .......................................................................... 9
Title field: For book titles, article titles and other titles in general .............................................. 9
Journal, Magazine, Newspaper, and Periodical Title fields ....................................................... 9
Pages field ..................................................................................................................................... 10
Date field ....................................................................................................................................... 10
Label field ...................................................................................................................................... 10
Keywords field ............................................................................................................................... 10
Notes, Research Notes and Abstract fields ............................................................................ 10
Export records directly into your EndNote library .......................................................................... 11
Export records from a database ................................................................................................ 11
Export records from Google Scholar: ......................................................................................... 12
Set the View at CQUniversity option in Google Scholar ......................................................... 12
Set EndNote as the default program for records exported from Google Scholar: ................... 13
Use the Import into EndNote function to import individual references ..................................... 13
Create a My Library account in google Scholar so you can download references in batches. 14
Select and download batches of references ........................................................................... 14
Fixing the capitalisation in exported records .............................................................................. 15
Set PDF handling preferences and configure Find Full Text so you will be ready to attach files.... 16
Set up PDF Auto Renaming ...................................................................................................... 16
Set up a PDF Auto Import Folder .............................................................................................. 16
Configure Find Full Text settings ............................................................................................... 17
Ways to attach files ....................................................................................................................... 18
Use Find Full Text to attach a file to a record ............................................................................ 18
Manually attach a File to a Reference ......................................................................................... 19
Import folders of PDFs from your computer ............................................................................... 20
Import a folder of PDF files ........................................................................................................ 20
Use your PDF Auto Import Folder to create a record with a file attached ................................. 21
Annotate PDF attachments in EndNote records ........................................................................... 23
Add a sticky note to the PDF ..................................................................................................... 23
Highlight, underline or strikethrough (cross out) text in the PDF .............................................. 23
Remove sticky notes, highlighting, underlining or strikethrough text ...................................... 23
Use Change/Move/Copy Fields to organise batches of references .......................................... 24
Create an EndNote library

Create an EndNote Library when you open the software the first time.
The first time you open EndNote, a Getting Started with EndNote window will appear.
1. Double click Create a New Library

2. Choose the location you want to save it to. Always keep your library on the hard drive of
your computer. It needs stable file paths to function properly.
   - If you are using your own computer, it is a good idea to make sure this is a top level
     folder in My Documents.
   - If you are on a university computer, it is recommended that you use a top level folder
     in Downloads. Your Desktop, My Documents and My Pictures folders will be synced
to OneDrive. You will get error messages if you try to store your EndNote library in
OneDrive

3. The default filename is My EndNote Library.enl. Change this to personalise it, e.g. Tom
Bromiley's Library.

4. Click Save. The new library will open and the name of the library will display in the top left
corner of the EndNote window.

Create an EndNote Library using the File menu
1. Open EndNote

2. Click File to open the File menu

3. Choose New...

5. Choose the location you want to save it to. Always keep your library on the hard drive of
your computer. It needs stable file paths to function properly.
   - If you are using your own computer, it is a good idea to make sure this is a top level
     folder in My Documents.
   - If you are on a university computer, it is recommended that you use a top level folder
     in Downloads. Your Desktop, My Documents and My Pictures folders will be synced
to OneDrive. You will get error messages if you try to store your EndNote library in
OneDrive

4. The default filename is My EndNote Library.enl. Change this to personalise it, e.g. Tom
Bromiley's Library.

5. Click Save. The new library will open and the name of the library will display in the top left
corner of the EndNote window.

NOTES:
- EndNote recommends that you use the same library for everything but use the group and
  group set functions to organise the different subject content.
- If you are using your EndNote library on both Windows and Mac computers, make sure
  there are no spaces in the library name, e.g. TomBromiley'sLibrary.
An overview of your library’s home screen

- **Toolbar** is at the top of the library. Above it is a series of menus, e.g. File.
- **Search panel** – This can be shown or hidden. It’s used for searching within your EndNote library.
- **Library of References** – The references in your library are listed here. The default is All References, but you can also limit to lists of references, e.g. by Group.
- **Groups Panel** – By default this is on the left. It displays your Groups and Group Sets.
- **Reference Panel** – This displays the Record for the reference, the Preview of the reference as it will appear in a reference list, and the PDF Attachment if there is one. Use the Layout menu in the bottom right to choose a display option that suits you
  - Right – Located to the right of the library of references with 3 tabs – Reference, Preview and PDF
  - Right-split – Located to the right of the library of references and split in half – Reference and Preview tabs to the left. PDF to the right.
  - Bottom – Located under of the library of references with 3 tabs – Reference, Preview and PDF
  - Bottom-split – Located under of the library of references and split in half – Reference and Preview tabs to the left. PDF to the right.
  - Off – No reference panel is shown. Double click on an individual reference to open the record for editing.
Type the record yourself
An EndNote record has fields that are used for creating a reference such as Author, Year, Title, etc. There are also other fields that are for your research notes and other data. The fields you need use to create the reference will depend on the reference type. Consult the relevant referencing manual on the CQUiversity Referencing Guides page to find out what you need to include in the reference.

Journal Article is the default Reference Type in EndNote. Click on the arrow at the right of the Reference Type box to select a different reference type (e.g. Book, Conference Proceedings, Map, Web Page, etc.).

The new reference window:

This example is for a journal article from a database since it is one of the most commonly used reference types. Other reference types use the same process, but different fields.

1. Open EndNote

2. Click the New Reference icon to open a new blank record. The default Reference Type is Journal Article. Use this one for a print article. Change to Electronic Article for an article you found in a database so the reference will include the DOI or URL.

3. Click in the Author field and enter the author’s Surname, comma, then first name e.g. Type Hamnett, Hilary J

4. If there is more than one author hit enter after each name to add a new line for the next name. Enter the name in the same format, e.g. Korb, Ann-Sophie

5. Click in the Year field, or use the tab key to go down to it. Enter the year, e.g. 2017
6. Go to the **Title** field. In the Title field type the article name in sentence case, e.g. The Coffee Project revisited: Teaching research skills to forensic chemists

7. Tab down to the **Journal** field and type the journal title exactly as it appears in the journal, e.g. Journal of Chemical Education.

8. In the **Volume** field, enter the volume number, e.g. 94

9. In the **Issue** field, enter the issue number, e.g. 4

10. In the **Pages** field, enter the numbers only, e.g. 445-450

11. **Add the DOI or URL**
   - If your referencing style requires the **URL**, go to the URL field and paste the article URL or journal home page URL there, e.g. [https://pubs.acs.org/doi/abs/10.1021%2Facs.jchemed.6b00600](https://pubs.acs.org/doi/abs/10.1021%2Facs.jchemed.6b00600)
   - If your referencing style requires the **DOI**, go to that field and add the number, e.g. 10.1021/acs.jchemed.6b00600

12. This is the end of the fields for referencing. Enter information in the other fields as desired, e.g. you could use the Label field to record where you searched and what your search terms were, or use the Access Date field to record the date you found the article.

13. Close the reference by clicking on the **X** button in the top right-hand corner of the New Reference window.

14. You will be prompted to save the changes. Click **Yes**.

15. The new reference will appear in the Reference panel of your library. Use the Preview tab to see how it will appear in your bibliography / reference list.
**Example Electronic Article record in EndNote**

| Author       | Hannett, Hilary J  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Korb, Ann-Sophie</td>
</tr>
<tr>
<td>Year</td>
<td>2017</td>
</tr>
<tr>
<td>Title</td>
<td>The coffee project revisited: Teaching research skills to forensic chemists</td>
</tr>
<tr>
<td>Journal</td>
<td>Journal of Chemical Education</td>
</tr>
<tr>
<td>Volume</td>
<td>94</td>
</tr>
<tr>
<td>Issue</td>
<td>4</td>
</tr>
<tr>
<td>Pages</td>
<td>445-450</td>
</tr>
<tr>
<td>DOI</td>
<td>10.1021/acs.jchemed.8b00600</td>
</tr>
<tr>
<td>Label</td>
<td>Library Search: “research skills”</td>
</tr>
<tr>
<td>Keywords</td>
<td>Add the authors' keywords or your own here.</td>
</tr>
<tr>
<td>Abstract</td>
<td>Add the abstract here if you want to refer to it.</td>
</tr>
<tr>
<td>Notes</td>
<td>Add up to 8 pages of notes here.</td>
</tr>
<tr>
<td>Research Notes</td>
<td>Add up to 8 pages of notes here.</td>
</tr>
<tr>
<td>Author Address</td>
<td><a href="mailto:hilary.hannett@glasgow.ac.uk">hilary.hannett@glasgow.ac.uk</a></td>
</tr>
<tr>
<td>Access Date</td>
<td>11 October 2018</td>
</tr>
<tr>
<td>Name of Database</td>
<td>American Chemical Society Journals</td>
</tr>
</tbody>
</table>

**Tips for Entering Data**

When you open an EndNote record for a reference, you will find labelled boxes to type details such as author names into. These are called fields.

When you manually create a reference, you copy and paste or type the data into these fields yourself.

When you export records from a database, the fields are automatically populated. All records exported from databases need to be checked to ensure that the data they contain is correct. You may need to manually edit some of these references.
Some field entry is for your research notes, or to keep track of where you searched and what your search terms were, or to add keywords to the record. It uses fields that don't appear in the reference or citation.

Below are some tips / guidelines for field entry.

**Author and Editor fields: How to put names in**

- Be consistent when you enter Author/Editor names
- Always enter author and editor names one name per line. Hit the Enter key to get a new line.
- Enter the full name if possible. It helps to distinguish between authors with the same surname. EndNote can abbreviate first and middle names. The preferred way is Family name, First name/Middle name. Options available include:
  - Brown, John Peter
  - Brown, J.P. (initials should be typed with a space or a full stop between them)
  - John Peter Brown (no comma)
  - J.P. Brown
- Enter multiple word family names as:
  - de Rossi, Charles
- Enter authors with titles such as ‘Jr’ or ‘III’ e.g. Alfred Smith Jr as:
  - Smith, Alfred, Jr.
- When entering corporate authors, put a comma after the name:
  - Department of Education,
  - Apple Computer Inc.,
- If a corporate author name includes a comma in the name itself, use two commas in place of the first comma:
  - University of California,, Irvine
- Enter all authors/editor names. EndNote will truncate with ‘et al’ or ‘and others’ as required by the bibliographic style. If you do not know all the authors’ names, the last author should be ‘et al’ or ‘and others’ followed by a comma.

**Title field: For book titles, article titles and other titles in general**

- EndNote styles can change the capitalization of titles but it is best to capitalise titles in the same way you would like it to appear in your bibliography
- If you are uncertain use sentence capitalization and upper case for the first letter of proper nouns.
- Enter titles without a period or any other punctuation at the end.
- Do not press the Enter key while typing titles into EndNote – allow titles to wrap to the next line

**Journal, Magazine, Newspaper, and Periodical Title fields**

Periodical titles are the exception to the general rules for titles.

- Enter the name of the journal or magazine exactly as it appears on the journal or magazine. (Journal article titles follow the guidelines above.)
• For newspapers, check your referencing guide. Some newspaper titles start with The. Enter
the name of the newspaper title exactly as it appears in the newspaper. If the referencing
guide says to omit “The” from the beginning, type the rest of the title exactly as it appears
on the newspaper.

Pages field
• Depending on the requirement of your style, you have two options for entering page
ranges:
  o 142–156
  o 142–56

• The style used to create the bibliography can change the page numbers to be either full or
abbreviated page ranges.

• Do not use commas in the Pages field for numbers in the thousands

Date field
• Enter dates as you would like them to appear in your bibliography. This usually means the
month is written as word.

• EndNote does not reformat dates.

Label field
• The label field can be used for many purposes e.g. database + search string, reprint
numbers, or an additional field for categorizing references.

Keywords field
• Use the keywords field to store keywords that you want to associate with the reference.

• Be consistent – use semicolons, backslashes or enter each keyword on a separate line

Notes, Research Notes and Abstract fields
• The Notes, Research Notes, and Abstract fields can each hold up to 64 KB (about 16
pages of plain text).

• Use the Notes/Research Notes fields to store personal reminders, quotations, and/or
annotations in.
Export records directly into your EndNote library

Export records from a database
A number of databases allow you to export records for articles and other resources directly from the database into your EndNote library. It only takes the records, however, so you will still need to download the PDF files and attach it to the record yourself.

Due to the structure of certain database records, information may occasionally be imported into incorrect fields within your EndNote library. These need to be edited manually. Some databases only allow you to export one record at a time. Others allow you to export batches of records.

The basic steps are:
1. Search the database.
2. Select the record/s you need from the results list.
3. Export to bibliographic manager, e.g. EndNote.
4. Download the PDF.
5. Attach the PDF to the record.

Occasionally you may find that you can’t select what you want from the results list. If that happens, open the full record and select from there.

Instructions for different platforms / databases are linked from the Exporting references into EndNote, filters and connection files page of the EndNote guide.
Export records from Google Scholar:
Google Scholar is a web search engine created by Google to locate academic and scholarly sources. These include peer-reviewed papers, theses, books, book chapters, abstracts and articles from academic publishers, professional societies, preprint repositories, universities and other scholarly organisations. You can set up Google Scholar to identify whether the resources it finds are held in full text at CQUniversity Library and/or any other libraries to which you have access.

Note: Many of the Library's resources do not appear in Google Scholar search results, however, it can be viewed as a complementary search tool for finding scholarly information.

Set the View at CQUniversity option in Google Scholar
2. Click on Settings at the top of the page (the wheel icon).
3. Click on Library Links in the left hand menu.
4. Type Central Queensland University into the search box.
5. Tick the checkbox beside CQUniversity – View @ CQUniversity
6. Click Save.

Now when you search Google Scholar, View @ CQUniversity will appear to the right of the results if CQUniversity Library has access to the full text.
Set EndNote as the default program for records exported from Google Scholar:
2. Open the menu in the top left corner and select Settings.
3. You’ll land on the Search results page. Go to Bibliography Manager and select Show links to import citations in.
4. Select EndNote from the drop down list.
5. Click Save.

Use the Import into EndNote function to import individual references.
1. Search on your keywords in Google Scholar.
2. Click the Import into EndNote link at the bottom of each search result you want.
3. Check each record. Basic reference details will be imported, but these may be incomplete or in the wrong fields.
4. Update each record as needed.
5. Download the PDF and attach it to the record.
Create a My Library account in google Scholar so you can download references in batches. The My Library account in Google Scholar is like the Folder option in a database or Library Search. It’s where save articles you find with Scholar searches.


2. Create a personal account. Staff and students can use their CQUUniversity email. If you use your university email, you will be prompted to log in with your staff/student log in on the following screen.

3. Click Enable to set up your scholar library

Select and download batches of references

1. Search Google Scholar

2. Click the star icon (Save) under the results you want to add to your scholar library. You will be prompted to log in to your My Library account if you haven’t done so already.

3. Click on My library in the top right to view the list of saved results.

4. Tick the boxes for the ones you want to download, and choose EndNote under Export

5. Click OK in the Opening citations window that pops up

6. The references will appear in your library in the Imported References folder

7. Check each record. Basic reference details will be imported, but these may be incomplete or in the wrong fields.

8. Update each record as needed.

9. Download the PDF and attach it to the record.
Fixing the capitalisation in exported records
Records exported from databases and GoogleScholar will need checking. If the information is incorrect or incomplete you need to edit the record to add missing details.

One of the most common problems is with case:

- author names or article titles in all capital letters, or
- article titles with each word capitalised.

EndNote has a Change case button like Word. You can use it to quickly fix the capitalisation of text in the fields of EndNote records.

Example using a title with each word capitalised:

1. Open the record.
2. Highlight the article title.
3. Open the Change Case menu and select Sentence case.
4. Save your changes.
5. Open the preview of the reference to show that it’s changed. (You may need to click on another reference in the library and then go back to this one to refresh the display)
Set PDF handling preferences and configure Find Full Text so you will be ready to attach files.

Set up PDF Auto Renaming
PDFs that are imported from Databases and Google Scholar often have file names that bear no relation to the article, e.g. Content Server(2).pdf or download.pdf. You can tell EndNote to rename the copies that you attach to your records so that they are identifiable.

1. Open EndNote.

2. Open the Edit menu in the toolbar and select Preferences (Windows users). Or, go to the EndNote tab and select Preferences (Mac users).

3. In the Preferences menu, select PDF Handling.

4. Select the PDF Auto Renaming Option that suits you.
   - Don’t rename = The file attachment will have whatever random name it was downloaded with.
   - Author + Year + Title = The lead author’s surname, the year of publication and as much of the title as will fit within the character limit for the file name.
   - Author + Title = The lead author’s surname and as much of the title as will fit within the character limit for the file name.
   - Author + Year = The lead author’s surname and the year of publication
   - Title = The title – up to 46 characters.
   - Custom = you can choose up to 3 EndNote record fields to include in the file name.

5. Click Apply, then OK (Windows users).

6. Click Save (Mac users)

Set up a PDF Auto Import Folder
You can set up a folder and set EndNote to automatically attach any PDF you add to that folder to a record in your Library. If it has a DOI, it will also populate the record with the reference details. This folder needs to be fairly close to the surface, e.g. Documents\EndNote\Articles for library. If the full name of the pdf including the file path is more than 248 characters long (including spaces) the pdf will not open.

1. Start by creating an empty folder with a short name that makes sense to you when you see it, e.g. Articles for Library.
2. Open EndNote.

3. Open the Edit menu in the toolbar and select Preferences (Windows users).
   Or, go to the EndNote tab and select Preferences (Mac users).

4. Select PDF Handling.

5. Tick the box for Enable automatic importing

6. Click Select folder and navigate to the new folder you created.

7. Click on it to add its file path to the box. This tells EndNote to use that folder for automatically importing PDFs.

8. Click Apply, then OK (Windows users).
   Click Save (Mac users)

Configure Find Full Text settings
The Find Full Text function will only work with articles available from certain large online electronic journal collections. The EndNote software has to be individually coded for each of these databases, so not all articles that are available online will be retrieved by the Find Full Text function. Normally only journal articles can be retrieved in full text.

If EndNote is able to find the PDF, it will download it and attach it to the reference as a File Attachment. The PDF will be stored in the DATA folder associated with your EndNote library.

1. Open EndNote

2. Click on Edit on the top menu bar to open the drop down menu.

3. Select Preferences.

4. Click on Find Full Text on the left hand side of the Preferences window. You will see a range of tools that can be used to retrieve full text:
   - DOI (Digital Object Identifier) – all users should tick this option.
   - PubMed Link Out – all users who import references from PubMed should tick this option
   - OpenURL – This helps when you are using Library Search.

5. Tick the box labelled OpenURL.

6. Below this, replace the existing text in the OpenURL Path box with:
   https://cqu-primo.hosted.exlibrisgroup.com/openurl/61CQU/61CQU_SP

7. If you are working on a campus computer, skip to Step 9.

8. If you are working off campus, or using your own device, add the following URL to the box below Authenticate with: http://ezproxy.cqu.edu.au/login?url=

9. Click OK.
Ways to attach files

Use Find Full Text to attach a file to a record

It is best to work with small batches of 5 to 10 references. If you search for too many at a time EndNote slows down and the Find Full Text function looks like it’s not working.

1. Highlight a small batch of the references in your library that you want EndNote to search for.

2. Click on the **Find Full Text** icon in the toolbar at the top of the library window.

3. **If you are working off campus**, you will be asked to authenticate with your CQUUniversity staff username / student number and password.

4. Click on **Continue** to begin the search.

5. Repeat steps 1 to 4 as needed for small batches of the remaining references you wish to search for the full text of.

A Find Full Text group set is located at the bottom of the Groups Pane (left-hand side of the library window). In this group set you can see auto-groups which allow you to monitor progress of the search.

If EndNote is unable to download the full text of the article, it may be able to find a URL link and insert it into the URL field of the reference. It may be possible to download the PDF using this link and attach it to the reference yourself.
Manually attach a File to a Reference

The PDF of a document will generally not be automatically imported with a reference. You need to attach the file yourself.

Only PDF files will display as attachments with the paperclip icon in EndNote, but a number of other formats can also be attached.

- PDF files, Word documents, PowerPoint presentations, spread-sheets, audio files, video files and others like this go into File attachment field.
- Photos, diagrams and tables go into the Figure attachment field. See How to create a figure record and attach an image file for instructions.

Method 1
1. Save a copy of the file to your computer.
2. Open your EndNote library
3. Open the reference you want to attach the file to.
4. Click on the paperclip icon for the Attach File function.
5. Navigate to the file you saved in the file selection window.
6. Highlight that file and click Open. A thumbnail will appear in the File Attachment field, e.g. a PDF icon for a PDF file.

Method 2
1. Right click on the File Attachment field to bring up the options menu.
2. Choose Attach File…
3. Click on Choose File to browse your files.
4. Highlight the file you need from your files and click Open. A thumbnail will appear in the File Attachment field.

Method 3
1. Save a copy of the file to your computer.
2. Open your EndNote library.
3. Open the reference you want to attach the file to.
4. Drag and drop that file into the File Attachment field of the EndNote record.
Import folders of PDFs from your computer

You might have folder of PDF files for articles you found before you started using Endnote. You can import these PDFs into your EndNote library to create records in your EndNote library. Each file will be attached to its own record. If they have a (Digital Object Identifier) DOI, the record should be automatically populated with the field data for the reference. If there is no DOI, you will need to manually enter the data yourself. Many PDFs will allow you to copy and paste text, so if you have the PDF pane open side by side with the record, you can try that.

Import a folder of PDF files

1. Open your EndNote Library
2. Open the File menu and choose Import.
3. Select Folder from the submenu.
4. For Import File, click Choose and navigate to the PDF you want to use.
5. Click Open
6. An Import Folder window will open. For Import Option, select PDF.
7. For Duplicates, choose one the three options:
   - Import All: This will import the file even if it’s a duplicate.
   - Discard Duplicates: This will exclude duplicate files.
   - Import into Duplicates Library: This imports duplicate files into a duplicate EndNote library.
8. For Text Translation, choose No Translation
9. Click Import. The reference will be imported into the Imported References group of your EndNote library.
10. Check the fields of the reference to see that the data has been correctly added.
11. Edit where necessary and save the changes.

Optional:
If the PDF file does not have a DOI, it will not be renamed when it is imported. You can rename the file attachment in EndNote.

1. Right click on the PDF icon in the File Attachment field.
2. Go to File Attachments in the menu
3. Choose Rename Attachment … from the submenu
4. Rename the file according to your preferences
Use your PDF Auto Import Folder to create a record with a file attached

1. Search for articles in Library Search or the databases.

2. Download the PDF files you want and save them to the new Auto Import folder you created.

3. Open EndNote and it should automatically start to import the articles. (If EndNote was already open, but the articles are not importing, close EndNote and re-open it to start the process.)

4. EndNote creates an Imported folder inside the Auto Import folder and moves the articles into it as it adds them to your library.

5. At the same time, a list of these imported references will appear in your EndNote library.

6. If there is a DOI, the details of the article will populate the fields and you'll have a full reference with PDF attached and renamed.

7. Double-check the details for the fields that display in the reference. Sometimes the automatically populated records have missing data, or data entered in the wrong field.

8. Edit as needed.

9. Save the record and close it.

The file is attached, but the record is empty:
Articles that don’t have a DOI will have a title that appears as the name of the PDF in pointy brackets, e.g. <Library-research-support.pdf>. For these, there is a little more work to do.

1. Open the reference.

2. Click on Layout in the bottom right corner of the Reference window. Select Right so the PDF Panel displays beside the record. This allows you to copy details across to the fields in the record for the article.

3. Copy the author and title information from the PDF to those fields of the record. Save and close the reference.

4. Go to Reference in the tool bar and click on Find Reference Updates.
5. If EndNote can find the details, it will populate the reference as it did for the article with the DOI.

6. If it was successful, double check the fields that display in the reference.

7. Edit as needed.

8. Save and close the completed record.

**There’s still no record:**
If EndNote can’t automatically populate the record for you, you’ll have to add the details in manually.

1. Open the reference again.

2. Type in the missing data, or copy and paste details from the PDF into the fields of the record.

3. Save and close the reference.

**NOTES:**
- Every file you attach to EndNote (either manually or with the automatic import) is then put into the My EndNote Library.Data folder. If you delete this .Data folder or move it to a different location from the library, EndNote won’t be able to find the file to open it. It’s best to leave this folder alone.

- If you are manually renaming files, use only letters and numbers for the file names. Sometimes other characters, e.g. hyphens and underscores can cause problems with PDFs in EndNote.
Annotate PDF attachments in EndNote records
You can view the PDF attachments side by side with the records they are attached to. Double click on a reference in your library to open the record. Use the Layout option in the bottom right corner of the record to open the PDF panel on the right. Once this panel is open, you can annotate the PDFs in your EndNote library. The annotation options are:

- Add a Sticky Note
- Highlight Text
- Underline Text
- Strikethrough Text

Add a sticky note to the PDF
1. Click the Sticky Note icon.
2. Click the place in the text where you wish to add the note.
3. Double click the Sticky Note icon to open it and type your note/comment.
4. Click the small cross in the top right corner of the Sticky Note to close it.
5. Save the changes to the EndNote record when you close it.

NOTE: Sticky notes can't be moved around the document. They stay where you first put them.

Highlight, underline or strikethrough (cross out) text in the PDF
1. Click the relevant icon.
2. Select the text you want to highlight, underline or cross out.
3. Save the changes to the EndNote record when you close it.

OR
1. Select the text you want to highlight, underline or cross out.
2. Click the relevant icon.
3. Save the changes to the EndNote record when you close it.

Remove sticky notes, highlighting, underlining or strikethrough text
1. Right click on the sticky note or section of highlighting, underlining or strikethrough text you want to remove.
2. Select Delete Annotation from the bottom of the pop-up menu.
3. Save the changes to the EndNote record when you close it.

Caution: If you click Remove, you will delete the PDF attachment.
Use Change/Move/Copy Fields to organise batches of references

It is possible to edit a single field in a batch of selected references at the same time. This can save time when you are tidying up your library or organising it to make it more searchable. For example, you can:

- Label a batch of references with the database you searched and the search terms you used to find them
- Add a keyword, or group of keywords to a batch of references.
- Replace the short code, e.g. c8h, with the full database name, e.g. CINAHL, for a batch of references you’ve just exported from a single database.
- Change a batch of references with titles in all capitals to titles in sentence case.

NOTE: This type of editing is not reversible, so use it with care.

Examples of how this function can be used:

Add a keyword, or group of keywords to a batch of references

The Keyword field of an EndNote record is searchable. If you add keywords to your references, you can find them by searching your library for those keywords.

1. Open your EndNote library.
2. Select the references you wish to edit.
3. Open the References menu and choose Show Selected References. This hides the references you don't want to add these keywords to.
4. Open the Tools menu and choose Change/Move/Copy Fields
5. The Change / Move copy fields window opens at the Change Fields tab. Select the Keyword field.
6. For Change, choose Insert after a field’s text. If you insert the new words after any existing ones, you won’t be deleting information you want to keep, such as keywords you added previously, or keywords that came from the database record.
7. Type the keywords you want to add to the field in the box beside the Change options. Separate keywords with semicolons or backslashes, or enter them on separate lines. Click OK.
8. A window will pop up asking for confirmation of the change. Click OK.
9. Yet another window will pop up to confirm that the changes have been made. Click OK.
10. Open one of the records and check the Keyword field to make sure the words have been added.
Label a batch of references with the database, search terms and the date you searched

If you are doing a systematic review, this use of the Change/Move/Copy Fields function can be useful in managing your search results, data mining and screening. If you label your references like this, you can generate a Subject Bibliography in EndNote that has the search details and the article abstracts in a single document. (See the Bibliography page of this EndNote guide for details)

For this example, I’m using the Label field to record the database, search string and date searched. This field is never populated with data from database records, so I can safely use Replace Whole field with.

1. Open EndNote
2. Select the references you wish to edit.
3. Open the References menu and choose Show Selected References. This hides the references you don’t want to label with this search string etc.
4. Open the Tools menu and choose Change/Move/Copy Fields
5. The Change / Move copy fields window opens at the Change Fields tab. Select the Label field. For Change, choose Replace whole field with.
6. Type the name of the database and your search terms and limiters into the text box beside the change options. Click OK
7. A window will pop up asking for confirmation of the change. Click OK.
8. Yet another window will pop up to confirm that the changes have been made. Click OK.
9. Open one of the records and check the Label field to make sure the words have been added.

NOTE: If you are using other fields such as Notes or Database, which are sometimes populated with information from the database record, it is a good idea to use either Insert after a field’s text or Insert before a field’s text. This keeps any text already in those fields and gives you the opportunity to review it.
Dealing with duplicate references

EndNote can cross check references of the same type and identify pairs with multiple matching fields, using Find Duplicates. There are defaults set for this function, but you can set your own preferences for dealing with duplicates.

Setting duplicate handling preferences

There are several fields available for comparison: Author, Year, Title, Secondary Title (=Journal Title), Volume, Issue, Pages, Section, Publisher, Place Published, Tertiary Title, Short Title, Subsidiary Author, Reference Type, Label. Choose the ones that best suit your own needs.

1. Open the Edit menu and select Preferences

2. Click Duplicates in the menu of the EndNote Preferences window.
3. In the Compare references based on the following fields box, tick the fields you want EndNote to compare. Untick the fields you don’t want to compare. The defaults are Author, Year, Title, and Reference Type.

4. Under Criteria, choose between Exact Match and Ignore spacing and punctuation.

5. Under Online Search Results, choose to automatically discard duplicates, or not. If you allow duplicates to be imported, you can compare the records later using the Find Duplicates option.

6. Click Apply to apply your choices.

7. Click OK to close the window.

**Find Duplicates**
Use this function to identify duplicate references in your library and deal with them. It will only compare pairs of references.

1. Open EndNote.

2. Select the All References group so that EndNote will search you whole library for duplicates.

3. Open the References menu from the toolbar and select Find Duplicates. EndNote will scan your records.
4. If you have duplicate references, a Find Duplicates window will open. One set of duplicates will be displayed side by side for you to compare. The fields that are different will be highlighted. Choose what you want EndNote to do with these records.

You have 3 options:

- **Keep this record**: This keeps the chosen record and deletes the other one. If there is unique, useful information in the record you are not keeping, copy it and paste it into the record you are keeping first.

- **Skip**: This keeps both records and puts them in a temporary Duplicates group so that you can go back and look at them later. This is useful if you have 3 or more duplicate records for the same source.

- **Cancel**: This tells EndNote to delete the most recently added version of the record.

5. When you have decided on one set of duplicates, the next set will appear for you to review. Continue working through the duplicates one set at a time.

When you delete the unwanted duplicate records, they go into the Trash group. To remove them completely, right click on Trash in the Groups pane and select Empty Trash.

Please note: The Empty Trash function cannot be undone.
Working in the temporary Duplicates group.

If you have 3 or more duplicate records for a single reference, but each has unique information in the additional fields, you can copy that information from one to the other before deleting.

1. Open each record for the reference and evaluate the data entered into the fields.

2. Use the record number to identify the most complete and accurate version. This is the one to keep.

3. Open each of the other duplicates in turn. Copy the unique information you wish to keep into a blank document.

4. Close each record as you finish with it.

5. Open the version you are keeping. Paste the unique information into the relevant fields.

6. Save the changes to the record.

7. Double check each record to make sure that you have all of the information you need.

8. Delete the unwanted duplicates.

9. Repeat this for the remaining sets of duplicate records in the Duplicates group.
Using Groups and Group Sets to manage your library
You can use groups and groups sets to organise your references by categories of your choosing. Groups can be added, deleted and changed without affecting the All References area of your library. References can belong to multiple groups. All references belong to the All References group as well as whichever groups you assign them to. Group Sets act like a subject heading to place your groups under.

Create a Group:

From the Menu bar:
1. Click on Groups in the top menu bar
2. Select Create Group from the drop-down menu
3. Type a name for the group / group set in the box that opens in the Groups Pane on the left

OR

From the Group Pane on the left:
1. Right click on My Groups
2. Select Create Group from the menu
3. Type a name for the group in the box that opens in the Groups Pane on the left

Create a Group Set:

From the Menu bar:
1. Click on Groups in the top menu bar
2. Select Create Group Set from the drop-down menu
3. Type a name for the group / group set in the box that opens in the Groups Pane on the left

OR
From the Group Pane on the left:
1. Right click on My Groups
2. Select Create Group Set from the menu.
3. Type a name for the group/group set in the box that opens in the Groups Pane on the left

Add a new Group to a Group Set:
1. Click on the name of the Group Set in the Groups Pane.
2. Follow the steps for creating a group. The new Group box will appear under the Group Set name.

Add existing groups to a group set:
1. Highlight/select a Group
2. Drag and drop it into the Group Set.
   OR
1. Select Create from Groups under the Groups menu
2. Type a name into the Group Name box
3. Select the Groups to add.
4. Click Create.

Add references to a Group
1. Highlight/select the reference/s in the library window
2. Drag and drop selected references into the group
   OR
1. Highlight/select the reference/s in the library window
2. Click on Add References To from the Groups drop-down menu
3. Select the name of the group from the list available
   OR
1. Highlight/select the reference/s in the library window
2. Right-click on the reference and go to Add References to
3. Select the group from the sub-menu
Smart Groups

Smart Groups are groups that have an inbuilt search query. EndNote automatically checks your new references against this query, and adds them to the smart group if they match.

1. Right click on My Groups.

2. Select Create Smart Group from the menu.

3. Type a name into the Smart Group Name box

4. Use the search boxes to create the search query that EndNote uses to automatically populate this group.

5. Click Create.

6. You will see that this new group has appeared in the Groups pane, and EndNote has added all of your references that meet the search criteria. Click on the Smart Group Name to open the group and view the references added to it.
Working in the reference pane

Choose which columns to display in the reference panel

Right click on the column heading row to bring up the column heading options. If it is ticked in the menu, it is currently displayed as a column heading in the reference pane.

- To stop an existing column heading from displaying, click on it to remove the tick.
- To display a column heading that is currently hidden, click on the name to add it. It will appear to the left of whichever column heading you used to open the menu.

Arrange the columns in the order you prefer

1. Click on the column heading
2. Drag it to where you want it and drop it.

Sorting your library

You can sort the references in your library using the column headings in the reference pane. For example to sort by author name, click the Author column heading. Click it a second time to reverse the sort order.

Read / Unread Status

Unread items appear in bold text in the reference pane. Read items are in regular text.

- To mark an item as read, click the large solid dot beside a bolded reference.
- To mark an item as unread, click the large empty circle beside an unbolded reference.

Turn Read/Unread status off

This setting is turned on by default in EndNote. Hiding the column doesn’t turn it off, but you can do that as well.

1. Open the Edit menu and choose Preferences
2. Click Read/Unread in the EndNote Preferences window.
3. Untick the Show unread references in bold text
4. Click Apply, then OK.
5. Hide the Read/Unread column.
Searching within your EndNote library

You can search your EndNote library for specific references. Search on words that have been added to any of the fields of a record, as well as within the text of PDF attachments. There are additional things you can search on such as when you added the record to your library.

1. Select the field or fields you wish to search, e.g. All fields, Keywords, Notes, on the left.

2. Type the words to search for into the box to the right of each chosen field.

3. Click Search

The search panel is above the reference panel of your EndNote library. It can be shown or hidden. If you can't see it, click Show Search Panel on the toolbar beside The Quick Search box.

Elements of the search panel:

- **Options**: In this menu, you'll find options to save searches and run saved searches.

- **Search Whole Library**: You can choose to search your whole library, or part of your library using the options in this drop down menu.

- **Match Case**: You only need this if you are looking for words with specific capital letters.

- **Match Words**: This will find an exact match on the word but exclude variants, e.g. EndNote would not find plurals ending in s if you search for the singular.

- **Fields to search**: The defaults fields are set to Author, Year and Title. You can change these using the drop down menus.

- **Comparison operators**: The default is set to Contains, but there are several options for how the field is searched, e.g. Field Begins With, and Word Begins With.

- **AND, OR, NOT**: These work the same was as in Library Search and Library databases.

- **Search boxes**: Add your search terms here.

- **Search button**: At the top left beside the Options button. Click this button or Hit enter to run your search.

For more information on using this function, go to Searching for References under Searching and Sorting in EndNote in your EndNote library’s Help pages.
Find and select Output Styles

Output Style = Referencing Style

In EndNote referencing styles are called Output styles. EndNote has a large number of styles already installed. You can choose one of these, or add new styles, e.g. harvard-cqu_2017. Styles are stored as files that you can download and install.

Choose an existing output style for your EndNote library

1. The default setting in the Bibliographic Output Styles box is Select Another Style. Click on the arrow beside this to open the menu. As you add styles this menu will get longer.

2. If the style you need is listed, select it from this menu. Your references will now display in this style in the preview pane.

3. If the style you need is not listed, click Select Another Style. This opens a window with the full range of options.

4. Browse the list or use the quick search to locate the style you want.

5. Highlight this style and click Choose. The new style will appear in the Output styles box in the toolbar and your references will display in this style in the preview pane.

Choose an existing output style in Word

1. Go to the EndNote toolbar in Word

2. Click the down arrow beside the Style box to bring up a list of styles

3. If the style you need is listed, select it from this menu. Your citations and bibliography will update to this style.
4. If the style you need is not listed, click Select Another Style. This opens a window with the full range of options.

5. Browse the list to locate the style you want.

6. Highlight this style and click OK. The new style will appear in the Output styles box in the toolbar and your citations and bibliography will update to this style.

Add a new output style to EndNote
1. Find the style you need to download.
   • For the harvard_cqu, APA 7th and AGLC styles, go to the Styles tab of the EndNote guide.
   • Additional styles are available from the EndNote website.
2. Download the style
3. Save the style file. It will be saved to the EndNote Styles folder on your computer.
4. After you have done this, follow the instructions to for choosing an existing style in EndNote and Word to set this new style as the output style for your library and document.

NOTE: If you are working between computers, you will need to install the new style on both.

Find additional styles
Additional styles are available from EndNote’s Output Styles page. You can get to this page from your EndNote Library.

1. Go to EndNote’s Output styles page https://www.endnote.com/downloads/styles/
2. Search for the style you need by name.
3. Download and Save the style file. It will be saved to the EndNote Styles folder on your computer.
Back up your library

You will spend hours developing and maintaining your EndNote library. This is where you keep all of your materials for your research so it is vital that you regularly back your library up. If something happens to your working library, you can resurrect it from a compressed copy.

1. Open your EndNote Library.

2. Open the File menu.

3. Select Compressed Library (.enlx).

4. Select the formatting options that suit you in the Compressed Library window.

5. Click Next and save in a location of your choosing.

Always use the Compressed Library option. When EndNote creates the library, it will also create a .DATA folder which contains various files connected with the library (PDF’s, Groups). When you compress the library, EndNote will include the .DATA folder. If you do not save the .DATA folder with you library .enl file you will not be able to open your pdf attachments or see your groups.

It is recommended that you keep at least 3 back-up copies of your library and document. One copy of each should be in a separate location, e.g. another drive. At least one copy of each should be in a separate physical location from the original library and document, e.g. the originals at home and the copies at work.

CAUTION: Never open or use your library in cloud storage (e.g. OneDrive, Google Drive, CloudStor, Dropbox) or on a storage device such as a USB or an external drive. It will corrupt your library. Cloud storage is only for storage. Always save your working library to the hard drive of your computer. Work from that copy.
How do I get help with EndNote?

Self help

- EndNote’s help section is very useful. Click the Help button 🔄 on the toolbar of your EndNote library to access this.
- CQUniversity’s EndNote LibGuide aims to show you the basic skills required to get started using the EndNote. It does not cover everything you will ever need to know.

For help installing EndNote, or fixing software issues contact TaSAC:

- Call from a Video kiosk in any campus library
- Call from your phone: 1300 666 620
- Call from a campus phone: extension 59090
- Email your request to tasac@cqu.edu.au
- Submit a request via the online Self Service Portal

For help using EndNote

- Contact TaSAC as above. Email queries are assigned to the Librarians Online Team (LOT). Calls are redirected to LOT if a librarian is available. If not a job is created and assigned to LOT so a librarian can respond when available.

OR

- Book a virtual face to face Ask a Librarian session at a time that suits you. Please note that all sessions are scheduled in Queensland time. You will need to allow for that if you are in a different time zone.